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1 Getting Started
Congratulations on your purchase of the ViewSonic Pocket PC V37. The V37 is a
Windows® Powered Pocket PC that enables you to keep your most important
business and personal information up-to-date and close at hand. Microsoft
ActiveSync increases the power of your device by allowing you to synchronize
information on your desktop or laptop computer with your V37.
This chapter introduces you to the internal and external components of the
ViewSonic Pocket PC V37.

Package Contents
When you unpack the contents of the Pocket PC V37, verify that you have all of
the items listed below.
•

ViewSonic Pocket PC V37

•

Stylus

•

AC adapter

•

USB cradle

•

SD dummy card (inside the slot)

•

Carrying case

•

ViewSonic Pocket PC V37 Companion CD (contains Microsoft ActiveSync®,
Microsoft Outlook 2000, ClearVue Image, ClearVue Presentation, and the
V37 User Guide in PDF format)

•

Visual SolutionsTM Developer Tools CD (contains Microsoft Visual Soutions
utilities and documentation)

•

User Guide

Accessories
You can expand your V37’s capabilities or replace lost parts by purchasing
accessories. Go to www.viewsonic.com for information about V37
accessories.

ViewSonic Pocket PC V37

1

48,&.67$57
8VLQJWKH9IRUWKHILUVWWLPH

,GHQWLI\LQJ&RPSRQHQWV
6'&DUG6ORW
,QIUDUHG ,5 3RUW

3RZHU%XWWRQ
6W\OXV
1RWLILFDWLRQ,QGLFDWRU 5HG

7RXFK6FUHHQ

%DWWHU\&KDUJLQJ,QGLFDWRU
$PEHU

/DQ\DUG(\HOHW
6FUROO'LDO
5HFRUG%XWWRQ

+HDGSKRQH
&RQQHFWRU
5HVHW6ZLWFK

3URJUDP%XWWRQV 
0LFURSKRQH

86%&UDGOH&RQQHFWRU



6SHDNHU
1DYLJDWLRQ3DG

3RZHU&RQQHFWRU
FRQQHFWWR$&DGDSWHU
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6HWWLQJWKH%DWWHU\6ZLWFK
The switch on the back of your Pocket PC V37 should be switched to the ON
(down) position. If this is not the case, please set it to ON.

 Make sure that the V37 is turned off.
 Unscrew the cap at the top of the stylus. Use the pointed tip of the cap to
slide the battery switch to the ON (down) position.

 The Notification indicator will flash red for approximately 30 seconds, and
then your V37 will automatically turn on and display the Welcome Wizard
screen.

IMPORTANT: Keep the battery switch set to ON (down position) unless
you need to restore factory defaults.

&KDUJLQJWKH%DWWHU\
Connect your V37 to an AC power source.


Plug the V37 into the USB cradle.
NOTE: You can also connect the V37 directly to the AC adapter without using
the USB cradle. For more information see “Battery Charging Options” in this
chapter.



Plug the appropriate end of the AC adapter into the power connector on the
USB cable.

NOTE: For information about battery replacement, see page 82.
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Plug the other end of the AC adapter into a grounded AC outlet.

The battery-charging indicator lights amber when charging is in progress.

 Fully charging may require a couple of hours. The amber battery-charging
indicator turns off when the battery is fully charged.

NOTE: Whenever possible, charge the battery by connecting the V37 to an AC
power source. This will keep the battery charged and prevent data loss or
damage to the battery in case the battery has been kept in a discharged state
for too long.

6WDUWLQJ<RXU9
Press the power button to turn the V37 on.
The first time you start your V37, the Welcome Wizard screen appears. The
wizard's on-screen instructions will lead you through the setup process. Follow
the instructions to complete the process and begin using your V37.

,QVWDOOLQJ0LFURVRIW$FWLYH6\QF
A key component of your V37 is the Microsoft ActiveSync® program. With
Microsoft ActiveSync, you can synchronize the information on your PC with
information on your V37 and update both with the most recent information.
ActiveSync is already installed on your V37. You need to install ActiveSync on
your PC. Follow the procedure below:
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IMPORTANT:
• Before installation, make sure you have Microsoft Outlook installed
on your PC. If you do not have Outlook, you can install Outlook 2000
from the provided ViewSonic Pocket PC V37 Companion CD.
• Do not connect your V37 to your PC before ActiveSync is installed.

 Turn on your PC.
 Insert the Microsoft ActiveSync Utility CD into the CD-ROM drive of your PC.
The ActiveSync installation screen should open immediately. If this does not
happen, double-click Setup.exe and go to Step 3.

 Click the arrow on the first screen to enter the main screen. Click Start
Here, then click Install ActiveSync 3.5. Click Install to start the
installation.

 When prompted, connect your V37 to your PC using the USB cradle as
follows:

(1) Place the V37 in the USB cradle.
(2) Connect the AC adapter to the power connector on the USB plug.
(3) Connect the USB cable to your PC. The Found New Hardware Wizard
will appear.

 Follow the on-screen instructions to to complete the USB driver installation.
The V37 will automatically connect to your PC.

 Follow the on-screen instructions to synchronize the V37 with your PC.
After your first synchronization, the data you have stored on your PC, such as
Calendar, Contacts, and Tasks, is copied to your V37. You’re now ready to take
it along with you when you go.
For more information on ActiveSync, see Chapter 4.
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Register Your Product
Go to www.ViewSonic.com to register your V37. You will need to know the
serial number of your V37 (see the back of the V37). To help with identification
in the event of theft or loss, keep this User Guide as a permanent record of your
purchase.

For More Information
For information on:

See this source

Complete information for operating the V37 User Guide (In addition to the paper version, the User
V37
Guide is also available as a PDF file on the ViewSonic Pocket
PC V37 Companion CD.)
Programs on your Pocket PC

V37 User Guide or ActiveSync Help on your PC.

Additional programs that can be
installed on your Pocket PC

ViewSonic Pocket PC V37 Companion CD

Connecting to and synchronizing with V37 User Guide or online Help. Tap Help on the Start menu to
a PC
view Help.
ViewSonic Customer Support

Chapter 9 of the V37 User Guide

Troubleshooting

V37 User Guide

Last-minute updates and technical
information

The Read Me files in the “Microsoft ActiveSync” folder on your
PC or the ViewSonic Pocket PC V37 Companion CD

The latest on Windows Powered
Pocket PCs

The Microsoft Mobile Devices Web site:
www.microsoft.com/mobile/pocketpc
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ViewSonic Pocket PC V37

+DUGZDUH)HDWXUHV
The illustrations below introduce you to the various buttons, connectors, ports,
and other features of your V37.

)URQW&RPSRQHQWV










5HI



&RPSRQHQW

'HVFULSWLRQ



7RXFK6FUHHQ

6HOHFWVPHQXFRPPDQGVRULQSXWWH[W



3URJUDP%XWWRQV

3URYLGHVDTXLFNZD\WRUXQDVSHFLILFSURJUDP%\GHIDXOW
WKH\DUH1RWHV&DOHQGDU&RQWDFWDQG7DVNVEXWWRQV OHIW
WRULJKW 



0LFURSKRQH

5HFHLYHVVRXQGDQGYRLFHWRUHFRUGYRLFHQRWHV



1DYLJDWLRQ3DG

0RYHXSGRZQOHIWRUULJKWLQDGRFXPHQW



6SHDNHU

6HQGVRXWPXVLFRUDXGLEOHUHPLQGHUVDQGDOHUWV



%DWWHU\&KDUJH
,QGLFDWRU

*ORZVDPEHUZKHQEDWWHU\LVEHLQJFKDUJHGDQGWXUQV2II
ZKHQEDWWHU\LVIXOO\FKDUJHG



1RWLILFDWLRQ
,QGLFDWRU

,QIRUPV\RXDERXWVFKHGXOHGDSSRLQWPHQWVDODUPV
UHPLQGHUVDQGYRLFHUHFRUGLQJVWDWXV
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5HDU&RPSRQHQWV

5HI


&RPSRQHQW

'HVFULSWLRQ

%DWWHU\6ZLWFK

5HVWRUHV\RXU9WRWKHIDFWRU\GHIDXOWVHWWLQJVDQGFOHDUV
DOOGDWDVWRUHGLQ5$0
127($OZD\VOHDYHWKHVZLWFKLQWKH21 GRZQ SRVLWLRQ
XQOHVV\RXQHHGWRSHUIRUPDKDUGUHVHW
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/HIW6LGH&RPSRQHQWV

5HI

&RPSRQHQW

'HVFULSWLRQ



/DQ\DUG(\HOHW

/DQ\DUGDWWDFKHVWRWKLVRSHQLQJ



6FUROO'LDO

6HOHFWVWKHKLJKOLJKWHGLWHPRUVFUROOVXSRUGRZQLQD
GRFXPHQW



5HFRUG%XWWRQ

5HFRUGYRLFHQRWHVE\SUHVVLQJDQGKROGLQJWKLVEXWWRQ



6WHUHR+HDGSKRQH &RQQHFWVVWHUHRKHDGSKRQHV
&RQQHFWRU



5HVHW6ZLWFK
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5HVWDUWV\RXU9 NOTE: UQVFUHZWKHUHDUFDSRIWKH
VW\OXVDQGXVHWKHSRLQWHGHQGRIWKHFDSWRUHVHWWKH9



7RS&RPSRQHQWV

5HI

&RPSRQHQW

'HVFULSWLRQ



,53RUW

%HDPVILOHVWRRUIURPRWKHUPRELOHGHYLFHVXVLQJLQIUDUHG
,5 



6'0HPRU\6',2 $FFHSWVDQRSWLRQDO6HFXUH'LJLWDOFDUGIRUH[WHQGHG
&DUG6ORW
PHPRU\FDSDFLW\RUDQ6',21RZFRPSDWLEOHE
:L)L FDUG



3RZHU%XWWRQ

7XUQV\RXU92QRU2IIRUWXUQVWKHEDFNOLJKW2QRU2IIE\
SUHVVLQJDQGKROGLQJWKLVEXWWRQ



6W\OXV6ORW

6WRUHVWKHVW\OXVZKHQLWLVQRWLQXVH

%RWWRP&RPSRQHQWV

5HI

&RPSRQHQW

'HVFULSWLRQ



&UDGOH&RQQHFWRU

&RQQHFWVWKH9WRWKH86%FUDGOHWRFKDUJHWKHEDWWHU\
DQGWRV\QFKURQL]HWKH9ZLWK\RXU3&



3RZHU&RQQHFWRU

&RQQHFWVWKH9WRWKH$&DGDSWHUZKHQQRWXVLQJWKH
86%FUDGOH
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986%&UDGOH
The USB cradle provides a convenient way to charge your V37 and connect your
V37 to a PC through a USB connection.

5HI







&RPSRQHQW

'HVFULSWLRQ

86%&RQQHFWRU

&RQQHFWVWR\RXU3&IRUGDWDV\QFKURQL]DWLRQ



3RZHU&RQQHFWRU &RQQHFWVWRWKH'&SOXJRIWKH$&DGDSWHU



3RFNHW3&
&RQQHFWRU

&RQQHFWVWR\RXU3RFNHW3&9



$&DGDSWHU

&RQQHFWVWRDQ$&RXWOHW
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%DWWHU\&KDUJLQJ2SWLRQV
:LWKWKHFUDGOH
 Slide your V37 into the cradle.
 Plug the appropriate end of the AC adapter into the power connector on
the USB.

 Plug the other end of the AC adapter into an AC outlet.

:LWKRXWWKHFUDGOH
Connect the DC plug from the AC adapter to the power connector on the
bottom of the V37, and plug the AC adapter into an AC outlet.
The battery-charger indicator lights amber when charging is taking place.

• Allow the battery to become fully charged (about two hours).
The amber Battery Charge Indicator turns off when the battery is fully
charged.
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Whenever possible, charge the battery by connecting your V37 to an AC power
source. This will keep the battery charged and prevent data loss or damage to
the battery in case the battery has been kept in a discharged state for too long.

6'0HPRU\DQG6',2&DSDELOLWLHV
Your V37 has an SDIO card slot which accepts an SD (Secure Digital) memory
card and SDIO Now! (Secure Digital Input/Output) compatible cards. You can
purchase an SD card to expand the memory capacity and capabilities of your
V37. Currently, you can also purchase an 802.11B (WiFi) card that supports the
SDIO Now! technology, and other peripherals may be available in the future.
NOTE: Make sure your SDIO card is compatible with SDIO Now! technology,
developed by bSquare Inc.
To insert an SD memory card or SDIO card:

 Slide the end of the card with the chipped corner into the SDIO slot (with the
label side and the V37’s front panel facing you).

 Push the card into the slot until it clicks into place.
To remove an SD memory card or SDIO card:
• Press the card. When the card pops out slightly, you can remove it.

9LHZ6RQLF3RFNHW3&9
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3DQHO%DVLF6NLOOV
This chapter introduces you to the basics of working with programs and
documents on your V37.

8VLQJWKH6W\OXV
Use the stylus to navigate and select objects on the V37 touch-screen.
NOTE: You can extend the stylus to hold it more comfortably.
• Tap: Touch the screen once with the stylus to open items and select options.
• Drag: Hold the stylus on the screen and drag across the screen to select
text and images. Drag in a list to select multiple items.
• Press and hold: Press and hold the stylus on an item to see a list of actions
available for that item. On the pop-up menu that appears, tap the action you
want to perform.

9LHZ6RQLF3RFNHW3&9



7RGD\6FUHHQ
When you turn on your V37 for the first time each day (or after 4 hours of
inactivity), you will see the Today screen. On the Today screen, you can see at a
glance important information for the day.
You can also display the Today screen by tapping

and then tapping Today.

1DYLJDWLRQ%DU
7DSWRVZLWFK
WRDSURJUDP

7DSWRFKDQJH9ROXPHRU0XWHDOOVRXQGV

7DSWRFKDQJHGDWHDQGWLPH
7DSWRRSHQDQLWHP
<RXUGD\DWDJODQFH

7DSWRFUHDWHDQHZLWHP

7DSWRYLHZFRQQHFWLRQVWDWXV

&RPPDQG%DU
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6WDWXV,FRQV
When the Today screen is displayed, you may see the following status icons on
the Command bar or Navigation bar. In most cases, you can tap a status icon to
display the associated control panel or more information related to the item.
For example, tap

,FRQ

to see information about the battery status.

0HDQLQJ
Speaker is On.
Speaker is Off.
Main battery is low.
Main battery is very low.
Main battery is fully charged.
Synchronization is beginning or ending.

9LHZ6RQLF3RFNHW3&9



1DYLJDWLRQ%DUDQG&RPPDQG%DU
The Navigation bar is located at the top of the screen. It displays the active
program and current time, and allows you to switch programs and close
screens.
The Navigation bar and Start menu:
7DSWRFKDQJH9ROXPHRU0XWHDOOVRXQGV

7DSWRTXLFNO\VHOHFWDSURJUDP
\RXKDYHUHFHQWO\XVHG

7DSWRVHOHFWDSURJUDP

7DSWRVHHDGGLWLRQDOSURJUDPV
7DSWRFXVWRPL]HWKHGHYLFH

Use the Command bar at the bottom of the screen to perform tasks in
programs. The Command bar includes menu names, buttons, and the Input
Panel button. To create a new item in the current program, tap New. To see the
name of a button, press and hold the stylus on the button. Drag the stylus off
the button so that the command is not carried out.
The Command bar:

1HZEXWWRQ

,QSXW3DQHOEXWWRQ

%XWWRQV
0HQXQDPHV
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5XQQLQJ3URJUDPV
Depending on the program you want to run, you can:
• Tap
or tap Start at the top of the screen and select from the menu. (You
can customize which programs you see on this menu. For information, see
section “Customizing Your V37” in Chapter 3).
• Tap
and then tap Programs to access additional programs. Tap the icon
to run the program.
• Press program buttons on the front of your V37 to open the program. The
icons on the buttons identify the programs they are associated with. (You
can customize which programs are associated with the buttons. For
information, see the section “Customizing Your V37” in Chapter 3).
The following table contains a partial list of the program icons on your V37.

,FRQ



3URJUDP

'HVFULSWLRQ

ActiveSync

Synchronize information between your V37 and PC.

Calendar

Keep track of your appointments and create
meeting requests.

Contacts

Keep track of your friends and colleagues.

Inbox

Send and receive email messages.

Pocket Internet Browse Web and WAP (Wide Area Protocol) sites,
Explorer
and download new programs and files from the
Internet.
Notes

Create handwritten or typed notes, drawings, and
recordings.

Tasks

Keep track of your tasks.

Pocket Excel

Create new workbooks or view and edit Excel
workbooks created on your PC.

Pocket Word

Create new documents or view and edit Word
documents created on your PC.

9LHZ6RQLF3RFNHW3&9



3RSXS0HQXV
With pop-up menus, you can quickly choose an action for an item. For example,
you can use the pop-up menu in the contact list to quickly delete a contact,
make a copy of a contact, or send an email message to a contact. The actions
in the pop-up menus vary from program to program. To access a pop-up menu,
press and hold the stylus on the name of the item that you want to perform the
action on.
When the menu appears, lift the stylus, then tap the action you want to
perform. Or tap anywhere outside the menu to close the menu without
performing an action.

3UHVVDQGKROGWRGLVSOD\WKHSRSXSPHQX
8VLQJWKHWLSRIWKHV\OXVWDSWKH
DFWLRQ\RXZDQW

7DSRXWVLGHWKHPHQXWRFORVHLW ZKHQ\RX
GHFLGHQRWVHOHFWDQRSWLRQRQWKHPHQX 

1RWLILFDWLRQV
Your V37 reminds you in a variety of ways when you have something to do. For
example, if you have set up an appointment in Calendar, a task with a due date
in Tasks, or an alarm in Clock, you will be notified in any of the following ways:
• A message appears on the screen.
• A sound, which you can specify, is played.
• The notification LED flashes.
To choose reminder types and sounds for your V37, tap Settings on the Start
menu. On the Personal tab, tap Sounds & Notifications.
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(QWHULQJ,QIRUPDWLRQ
You have several options for entering new information:
• Use the Input Panel to enter typed text, either by using the soft (on-screen)
keyboard or other input methods.
• Write directly on the screen.
• Draw pictures on the screen.
• Speak into the microphone to record a message. For more information on
using the microphone, see the section on “Recording a Message”.

(QWHULQJ7H[W8VLQJWKH,QSXW3DQHO
Use the Input Panel to enter information in any program on your V37.
You can either type using the soft (on-screen) keyboard or write using the Block
Recognizer or Letter Recognizer. In any case, the characters appear as typed
text on the screen.
To show or hide the Input Panel, tap the Input Panel button. Tap the arrow
next to the Input Panel button to see your choices.

6HOHFWDQLQSXWPHWKRG
7DSWRVHH\RXUFKRLFHV
,QSXW3DQHOEXWWRQ
When you use the Input Panel, your V37 anticipates the word you are typing or
writing and displays it above the Input Panel. When you tap the displayed word,

9LHZ6RQLF3RFNHW3&9



it is inserted into your text at the insertion point. The more you use your V37,
the more words it learns to anticipate.

7DSKHUHLIWKLVLVWKHULJKWZRUG

NOTE: To change word suggestion options, such as the number of words
suggested at one time, tap Setting on the Start menu. On the Personal tab,
tap Input, then tap the Word Completion tab.

%ORFN5HFRJQL]HU
With Block Recognizer, you can use the stylus to input characters and words.
To type with Block Recognizer:

 Tap the arrow next to the Input Panel button, and then tap Block
Recognizer.

 Write a letter in the box.
When you write a letter, it is converted to typed text that appears on the
screen. For specific instructions on using Block Recognizer, open Block
Recognizer, and then tap the question mark (?) next to the writing area.

6RIW.H\ERDUG
The Soft Keyboard is an on-screen keyboard displayed at the bottom of the
screen.
To type with the soft keyboard:

 Tap the arrow next to the Input Panel button, and then tap Keyboard.
 On the keyboard that is displayed, tap the keys with your stylus.
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/HWWHU5HFRJQL]HU
With Letter Recognizer, you can write letters using the stylus just as you would
use a pen on paper.
To type with Letter Recognizer:

 Tap the arrow next to the Input Panel button, and then tap Letter
Recognizer.

 Write a letter in the box.
When you write a letter, it is converted to typed text that appears on the
screen. For specific instructions on using Letter Recognizer, open Letter
Recognizer and then tap the question mark next to the writing area.

7UDQVFULEHU
With Transcriber you can write anywhere on the screen using the stylus just as
you would on paper. Unlike Letter Recognizer and Block Recognizer, you can
write a sentence or more of information; then, you pause and let Transcriber
change the written characters to typed characters.
To type with Transcriber:

 Tap the arrow next to the Input Panel button, and then tap Transcriber.
 Write anywhere on the screen.
For specific instructions on using Transcriber, open Transcriber and then tap the
question mark in the lower-right corner of the screen.

9LHZ6RQLF3RFNHW3&9



:ULWLQJRQWKH6FUHHQ
In any program that accepts writing—such as the Notes program and the
Notes tab in Calendar, Contacts, and Tasks—you can use your stylus to write
directly on the screen. Write the way you do on paper. You can edit and format
what you have written and convert the information to text later.
To write on the screen, tap the Pen button to switch from tapping to writing
mode. This action displays lines on the screen to help you write.

7DSWKH3HQEXWWRQDQGXVH
\RXUVW\OXVOLNHDSHQ

Some programs that accept writing may not have the Pen button. See the
documentation for that program to find out how to switch to writing mode.
If you want to edit or format writing, you must select it first.
To select writing:

 Press and hold the stylus next to the text you want to select until the
insertion point appears.

 Without lifting, drag the stylus across the text you want to select.
If you write accidentally on the screen, tap Tools, then Undo, and try again.
You can also select text by tapping the Pen button to deselect it and then
dragging the stylus across the screen.
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You can cut, copy, and paste written text in the same way you work with typed
text: press and hold the stylus on the selected words and then tap an editing
command on the pop-up menu, or tap the command on the Edit menu.
To convert writing to text, tap Recognize on the Tools menu.
If you want to convert only certain words, select them before tapping
Recognize on the Tools menu (or press and hold the selected words and then
tap Recognize on the pop-up menu). If a word is not recognized, it is left as
writing.

6HOHFWWKHWH[W\RXZDQWWR
FRQYHUWDQGWDS5HFRJQL]H
RQWKH3RSXSPHQX

9LHZ6RQLF3RFNHW3&9

<RXUKDQGZULWLQJLV
WXUQHGLQWRWH[W



If the conversion is incorrect, you can select different words from a list of
alternates or return to the original writing. To do so, press and hold the
incorrect word (tap one word at a time). On the pop-up menu, tap Alternates.
A menu with a list of alternate words appears. Tap the word you want to use, or
tap the writing at the top of the menu to return to the original writing.

7DSWKHZRUG\RXZDQW
WRXVH
2UWDSRXWVLGHWKH
SRSXSZLQGRZWRUHWXUQ
WR\RXURULJLQDOZULWLQJ

Some tips for getting good recognition are listed below:
• Write on the lines and draw descenders below the line. Write the cross of the
“t” and apostrophes below the top line so that they are not confused with
the word above. Write periods and commas above the line.
For better recognition, use the Tools menu to increase the zoom level to 300%.
• Write the letters of a word close together and leave big gaps between words.
• Hyphenated words, foreign words that use special characters such as
accents, and some punctuation cannot be converted.
• If you add writing to a word to change it (such as changing a “3” to an “8”)
after you attempt to recognize the word, the writing you add will not be
included if you attempt to recognize the writing again.
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'UDZLQJRQWKH6FUHHQ
You can draw on the screen in the same way that you write on the screen. The
difference between writing and drawing on the screen is how you select items
and how they can be edited. For example, selected drawings can be resized,
while writing cannot.
To create a drawing, cross three ruled lines on your first stroke. A drawing box
appears. Drawings that do not cross three ruled lines will be treated as writing.

7KHGUDZLQJER[LQGLFDWHVWKH
ERXQGDULHVRIWKHGUDZLQJ

You may want to change the zoom level so that you can more easily work on or
view your drawing. Tap Tools, then choose a zoom level.
If you want to edit or format a drawing, you must select it first.
To select a drawing, press and hold the stylus on the drawing until the selection
handle appears. To select multiple drawings, deselect the Pen button and then
drag to select the drawings you want.
You can cut, copy, and paste selected drawings by pressing and holding the
selected drawing and then tapping an editing command on the pop-up menu, or
by tapping the command on the Edit menu. To resize a drawing, make sure the
Pen button is not selected, and then drag a selection handle.
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5HFRUGLQJD0HVVDJH
In any program where you can write or draw on the screen, you can also
quickly capture thoughts, reminders, and phone numbers by recording a
message. In Calendar, Tasks, and Contacts, you can include a recording in the
Notes tab. In the Notes program, you can either create a stand-alone
recording or include a recording in a written note. If you want to include the
recording in a note, open the note first. In the Inbox program, you can add a
recording to an email message.
To create a recording:

 Hold the V37’s microphone about three inches from your mouth.
 Press and hold the record button on the left side of the unit. If the speaker is
not muted, a beep indicates that your V37 is recording. The notification LED
at the top of the unit glows red while recording is in progress.

 While holding down the record button, speak into the microphone.
 To stop recording, release the record button. Two beeps will sound. The new
recording appears in the note list or as an embedded icon.

NOTE: You can also make a recording by tapping the Record button on the
Recording toolbar.
To play a recording:
• Tap it in the list or tap its icon in the note.

,QGLFDWHVDQHPEHGGHG
UHFRUGLQJ

7DSWREHJLQUHFRUGLQJ

7DSWRVKRZRUKLGHWKH
5HFRUGLQJWRROEDU
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5HFRUGLQJ)RUPDWV
Your V37 supports several formats for voice notes. The formats vary in both the
quality of the recording and the size of the sound file. When selecting a
recording format, you should consider the quality you need as well as how
much storage memory the recording will use on your V37.
Not all recording formats are compatible with other software or computers. If
you will share your recordings with others or transfer a recording to your PC, be
sure to choose a recording format that is supported by the software used to
play recordings on the other computer.
To select a recording format:

 On the Start menu, tap Settings, and then tap the Input icon.
 On the Options tab in the Input control panel, select a voice recording
format from the drop-down list.

The list of recording formats on your V37 indicates the sample rate, whether
the format is stereo or mono, and how much storage memory is required per
second of recording. You may need to experiment with different sample rates
and formats to determine which format best suits your voice.

8VLQJ0\7H[W
When using Inbox, use My Text to quickly insert preset or frequently used
messages into the text entry area. To insert a message, tap My Text, and then
tap a message.
NOTE: After inserting a My Text message, you can add text to it before you
send the message.
To edit a My Text message, on the Tools menu, tap Edit My Text Messages.
Select the message you wish to edit and make desired changes.

9LHZ6RQLF3RFNHW3&9
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0DQDJLQJ<RXU9
This chapter tells you how to effectively manage power and memory, and how
to add/remove programs and back up your data.

0DQDJLQJ3RZHU
It is important to maintain a continuous power supply to the V37 to prevent
data or files stored in RAM from being damaged. Your V37 can operate either on
external AC power or internal battery power. Note that you will lose any
information, programs or settings that you have added if the battery completely
runs out of power.
A fully charged battery should provide power for up to 8 hours of use. The
operating time of a fully charged battery depends on how you are using the
V37. Using some functions, such as some of the multimedia features or a
Secure Digital card, may consume extra battery power.
You should recharge the battery when a warning of low power is displayed on
your V37, or the V37 will turn off automatically. You will need to connect the
V37 to external AC power for charging before you can use it again.
See Chapter 1 for information about powering on your V37.
To check the remaining power:

 On the Start menu, tap Settings.
 On the System tab, tap the Power icon.
The remaining power is displayed on a status bar in the Power control panel.

3RZHU6DYLQJ7LSV
Follow these suggestions to maximize the battery’s operating time:
• Turn off the backlight. Press and hold the power button to turn off the
backlight, or use the Backlight control panel to set the backlight to turn off
automatically after a short period of inactivity.
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• Suspend frequently. Use the Power control panel to shorten the length of
continuous idle time before your V37 auto-suspends. Press the power button
to turn off your V37 when it is not in use, even for a short time.
• Always use AC power when connecting your V37 to your PC. Note
that your V37 will not auto-suspend while it is connected.
• Turn off sounds. Use the Sounds & Notifications control panel to turn off all
but the most necessary system sounds.
• Avoid using memory card accessories while on battery power. Some
memory cards use considerable power and will quickly drain your battery.
• Do not “listen” for infrared transfers. Although you can set your Pocket
PC to constantly monitor the IR port for files sent from other devices, doing
so will quickly drain your batteries.

0DQDJLQJ0HPRU\
Your V37 uses two kinds of memory: storage and program memory (RAM), and
optional memory cards.

6WRUDJHDQG3URJUDP0HPRU\
RAM (Random Access Memory) on your V37 is shared between storage memory
and program memory. “Storage memory” is used to store the data you create
and additional programs you install. “Program memory” is used to run
programs on your V37. Your V37 automatically manages the allocation between
storage and program memory. However, in some situations, such as when the
memory is running out, your V37 may not be able to automatically adjust the
allocation.

0HPRU\&DUGV
Memory cards are small, removable flash storage cards that enable you to
expand the memory of your V37. You can use memory cards for backup
storage, archives, or to transfer large files to other devices. Your V37 supports
Secure Digital memory cards. Memory cards can be purchased from a variety of
third-party vendors.

6'5$00HPRU\$OORFDWLRQ
The V37 has 64 MB of SDRAM memory:
• For the USA and European models: 27.5 MB is used by the Pocket PC 2002
Operating System, applications, and drivers.
For the Asian models: 35.5 MB is used by the Pocket PC 2002 Operating
System, applications, and drivers.
• The remaining memory is available for user applications and file storage:
36.5MB for the USA and Europe V37 models and 28.5MB for the Asian V37
models.
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Memory Map for 64MB SDRAM:

'HVFULSWLRQ

86$DQG(XURSHDQ
0RGHOV

$VLDQ0RGHOV

)ODVK520,PDJHDOORFDWHGIRU
0%
3RFNHW3&2SHUDWLQJ6\VWHP
DQGDSSOLFDWLRQV

0%

'ULYHUV

0%

0%

$YDLODEOHIRUXVHUDSSOLFDWLRQVDQG 0%
ILOHVWRUDJH

0%

7RWDO0HPRU\

0%

0%

NOTE: The USA and European V37 models have an additional 36 MB of Flash
ROM memory available for file storage called "My Flash Disk."
The Asian V37 models have an additional 31 MB of Flash ROM memory available
for file storage. This additional Flash ROM is smaller because the Asian
operating systems require more space.
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)LQGLQJDQG2UJDQL]LQJ,QIRUPDWLRQ
The Find feature on your V37 helps you quickly locate information.
To find a file, on the Start menu, tap Find. Enter the text you want to find,
select a data type, and then tap Go to start the search.
NOTE: To quickly find information that is taking up storage space on your V37,
select Larger than 64KB under Type.
You can also use the File Explorer to find files on your V37 and to organize
these files into folders. On the Start menu, tap Programs, and then tap File
Explorer.

7DSWRFKDQJHIROGHUV

6HOHFWWKHVRUWRUGHUIRUWKHOLVW
7DSWKHIROGHUQDPHWRRSHQLW

3UHVVDQGKROGWRFUHDWHDQHZIROGHU
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&XVWRPL]LQJ<RXU9
You can customize the settings of the V37 to your own preferences.
Tap Start, then tap Settings. You can tap any of the icons on the Personal,
System, or Connections tabs to customize your V37. The customization
options are as follows:

2SWLRQV
3(5621$/ Buttons

6<67(0

'HVFULSWLRQ
Assigns your favorite programs to the program buttons,
and sets the repeat rate of the scroll dial.

Input

Sets the settings related to Block Recognizer, soft
keyboard, Letter Recognizer and Transcriber input
methods.

Menus

Selects the items that appear on the Start menu and the
New menu on the Today screen.

Owner
Information

Saves your personal information.

Password

Sets the password to your V37 to protect the stored
data.

Sounds &
Notifications

Sets the conditions and types of the sounds, system
volume, and ways of notifications.

Today

Sets the items that appear on the Today screen.

About

Shows information about the version of the operating
system, the name of the Pocket PC, and copyrights.

Backlight

Adjusts the backlight of the display.

Clock

Sets the current time and alarm.

Memory

Adjusts the allocation of data and program storage.

Power

Shows the remaining battery and external AC power, and
set the time for the V37 to turn off automatically.

Regional
Settings

Sets the region of your location, and formats for number,
currency, time and date.

Remove
Programs

Removes programs pre-installed in RAM.

Screen

Realigns the touch screen for accurate taps.
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6HWWLQJD3DVVZRUG
A password can safeguard your V37 against unauthorized use. To set your
password:

 Tap Start, tap Settings, then tap the Password icon on the Password tab.
 Tap the digits or characters to set your password. You can set a four-digit
password, or a long password containing a combination of at least seven
characters, digits or punctuation.

 You can set the time for the V37 to prompt for a password after idling.
 Tap OK.

$GGLQJRU5HPRYLQJ3URJUDPV
$GGLQJ3URJUDPV
You can add even more functionality to your V37 by installing additional
software and programs. A wide variety of software is available for Windows
Powered Pocket PCs, ranging from custom business applications and system
utilities to games and entertainment. Some programs are available from
software vendors or on the Web.
Install only programs designed specifically to run on a Pocket PC personal
digital assistant and/or a Windows Powered Pocket PC. You cannot run
programs designed for Windows on your V37. In addition, you may need a
version of the program designed specifically for the X-Scale processor used by
your V37.
Install software to your V37 by first loading the installation files onto your PC.
Use ActiveSync on your PC to transfer and install programs to the storage
memory (RAM) in your V37.

5HPRYLQJ3URJUDPV
To free storage memory on your V37, you can remove programs you no longer
use. Only programs that are stored in RAM can be removed.
Programs pre-installed in Flash ROM cannot be removed; however, these
programs do not use storage memory.
To remove a program:

 On the Start menu, tap Settings.
 On the System tab, tap Remove Programs.
 Select the program in the list, and then tap Remove.
NOTE: If the program does not appear in the list of installed programs, use
File Explorer on your V37. Locate the program, press and hold the stylus on
the program, and then tap Delete on the pop-up menu.
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%DFNLQJ8S'DWD
To prevent loss of data, you should back up your V37 frequently. Your V37
comes with two programs for backing up data:
• Microsoft ActiveSync. ActiveSync enables you to back up data to your PC.
You can back up all data on your V37, or only your PIM databases (Calendar,
Contacts, and Tasks). You can set ActiveSync to back up automatically each
time you connect, or you can back up manually, whenever you choose. For
more information, see ActiveSync Help on your PC.
• Backup. Backup enables you to back up all data stored in the internal
(RAM) memory on your V37. You can save the backup file on an optional
Secure Digital memory card.

8VLQJ%DFNXS
Backup gives you added flexibility in backing up your valuable data. With
Backup, you can back up all data in RAM. You can save the backup file to an
optional SD memory card, so you can safeguard your data even while you are
traveling or away from your PC.
NOTE: An internal storage device called “My Flash Disk” is included. When
using Backup, you can choose this disk as your target backup device.

%DFNLQJXSGDWDXVLQJ%DFNXS
 Close all running applications and insert a memory card.
 Disconnect your V37 from your PC.
 On the Start menu on your V37, tap Programs and then tap the Backup
icon.

 Tap Backup, then tap Next.
 Tap your preference of storage media for backing up your data, then tap
Next.

 Tap the item you want to back up, then tap Next.
 Tap Backup, then tap Yes to start the backup process.
 Remove the memory card after the backup is complete.
CAUTION:
• Never delete the backup file in the memory card. If the backup file is
deleted, the backup data will be lost and cannot be restored.
• When you use the backup file to restore information, information on
your V37 is replaced with the information stored in the backup file.
If you have created files on your V37 since the last backup and do
not want to delete these files during the restore process, move the
files from your V37 to your PC--or to an optional memory card-before restoring the information.
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5HVWRULQJGDWDXVLQJ%DFNXS
 Close all running applications and insert a memory card with the backup
data.

 Disconnect your V37 from your PC.
 On the Start menu tap Programs, then tap the Backup icon.
 Tap Restore, then tap Yes.
 Tap your preference of storage media for restoring your data, then tap Next.
 Tap the item you want to restore, then tap Next.
 Tap Restore, then tap Yes to start the restore process.
 Remove the memory card after the restore process is complete, and reset
your V37.

IMPORTANT: When you restore data, your V37 must have the same regional
settings that it had when you completed the backup; otherwise, you will not be
able to restore the files. To change regional settings, on the Start menu, tap
Settings, and then tap the Regional Settings icon on the System tab. Select
your region from the drop-down list.
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0LFURVRIW$FWLYH6\QF
This chapter tells you what the Microsoft ActiveSync program is and what you
need to do to use it.

8VLQJ0LFURVRIW$FWLYH6\QF
NOTE: ActiveSync is already installed on your V37. You need to install
ActiveSync on your PC. (For information on installing ActiveSync, see Step 5 of
the Quick Start procedure in Chapter 1, “Installing Microsoft ActiveSync.”)
Microsoft ActiveSync allows you to synchronize the information on your PC with
information on your V37. Synchronization compares the data on the two sides
and updates both computers with the most recent information. For example,
you can:
• Keep your Pocket Outlook Contacts, Calendar, and Tasks databases up-to
date by synchronizing your V37 with Microsoft Outlook data on your PC.
IMPORTANT: Outlook must be installed on your PC in order to synchronize
your email data.
• Synchronize email messages in your V37 Inbox with email messages in
Microsoft Outlook on your PC.
• Synchronize Microsoft Word and Microsoft Excel files between your V37 and
PC. Your files will be automatically converted to the correct format.
With ActiveSync, you can also:
• Back up and restore your V37 data.
• Copy (rather than synchronize) files between your V37 and PC.
• Add and remove programs on your V37.
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6\QFKURQL]LQJ'DWD
Once you have created a synchronization partnership and completed the first
synchronization, you can initiate synchronization from your V37. Follow this
procedure:

 Connect your V37 to your PC. (See “Connecting Your PC” in Chapter 1.)
 On your V37, tap
 Tap

, and then tap ActiveSync.

to begin synchronization.

9LHZFRQQHFWLRQVWDWXV
7DSWRFRQQHFWDQGV\QFKURQL]H
7DSWRVWRSV\FQFKURQL]DWLRQ

9LHZV\QFKURQL]DWLRQVWDWXV

7DSWRFKDQJH9ROXPHRU0XWHDOOVRXQGV
By default, ActiveSync does not automatically synchronize all types of
information. Use ActiveSync options to turn synchronization on and off for
specific information types. You can:
• Control when synchronization occurs by selecting a synchronization mode.
For example, you can synchronize continually while the V37 is connected or
only when you choose the synchronize command.
• Select which information types are synchronized and control how much data
is synchronized. For example, you can choose how many weeks of past
appointments you want synchronized.
For information on setting ActiveSync options and using ActiveSync on your PC,
see ActiveSync Help on the PC. For information on using ActiveSync in your
V37, see ActiveSync Help on the V37.
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&RQQHFWLQJWR<RXU3&
CAUTION: Do not shut down or restart your PC while your V37 is
connected. Turn off your V37 or disconnect the USB cable before you
shut down your PC.

&RQQHFWLQJE\86%&DEOH
CAUTION: Before you connect your V37 to the cradle, be sure of the
following: your PC is on, you have installed ActiveSync on your PC, and
ActiveSync is configured to allow a USB connection.
You can keep your V37 in the cradle when you are not carrying it with you,
which keeps it charged and synchronized.
For instructions on connecting, see “Installing Microsoft ActiveSync” in Chapter
1.

&RQQHFWLQJE\,QIUDUHG
You can use the IR port to synchronize data with your PC, in place of using the
cable.
IR ports can be found on many notebook computers; however, on a PC, you
may need to install and configure an IR port. To install the port, follow the
manufacturer’s instructions.
For complete instructions on connecting to your PC by infrared, refer to
ActiveSync Help on your PC.
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3RFNHW2XWORRN
This chapter introduces you to the basics of Microsoft Pocket Outlook, including
Calendar, Contacts, Tasks, Notes and Inbox.

6FKHGXOLQJ$SSRLQWPHQWV0HHWLQJV
Use Calendar to schedule appointments, including meetings and other events.
You can check your appointments in one of several views (Agenda, Day, Week,
Month, and Year) and easily switch views by using the View menu.

7DSWRJRWR7RGD\
7DSWRGLVSOD\RUHGLWWKH
DSSRLQWPHQWGHWDLOV

7DSWRFUHDWHDQHZDSSRLQWPHQW
NOTE: You can customize the Calendar display (for example, change the first
day of the week), by tapping Options on the Tools menu.
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&UHDWLQJDQ$SSRLQWPHQW
 In Day or Week view, tap the desired date and time for the appointment.
 Tap New.

7DSWRUHWXUQWRWKHFDOHQGDU WKH
DSSRLQWPHQWLVVDYHGDXWRPDWLFDOO\ 

7DSWRFKRRVHIURPSUHGHILQHGWH[W
7DSWRFKRRVHIURPSUHYLRXVO\
HQWHUHGORFDWLRQV
7DSWRVHOHFWDWLPH
7DSWRVHOHFWDGDWH

1RWHVLVDJRRGSODFHIRU
PDSVDQGGLUHFWLRQV

 When using the Input panel, tap first to select the field, and then enter a
description and a location.

 If needed, tap the date and time to change them.
 Enter other desired information. You will need to hide the Input panel to see
all available fields.

 To add notes, tap the Notes tab. You can enter text, draw, or create a

recording. For more information on creating notes, see “Notes: Capturing
Thoughts and Ideas” later in this chapter.

 Tap OK to return to Calendar.
NOTE: If you select Remind me in an appointment, your V37 will remind you
according to the options set in the Sounds & Notifications control panel.
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8VLQJWKH6XPPDU\6FUHHQ
When you tap an appointment in Calendar, a summary screen displays. To
change the appointment, tap Edit.

9LHZDSSRLQWPHQWGHWDLOV

9LHZ

7DSWRFKDQJHDSSRLQWPHQW

&UHDWLQJ0HHWLQJ5HTXHVWV
You can use Calendar to set up meetings with users of Outlook or Pocket
Outlook. The meeting notice will be created automatically and sent either when
you synchronize Inbox or when you connect to your email server. Indicate how
you want meeting requests sent by tapping Tools and then Options. If you
send and receive email messages through ActiveSync, select ActiveSync.
To schedule a meeting:

 Create an appointment.
 In the appointment details, hide the Input panel, and then tap Attendees.
 From the list of email addresses in Contacts, select the meeting attendees.
The meeting notice is created automatically and placed in the Outbox folder.
For more information on sending and receiving meeting requests, see Calendar
Help and Inbox Help on your V37.
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0DQDJLQJ&RQWDFWV
Contacts maintains a list of your friends and colleagues so that you can easily
find the information you are looking for, whether you are at home or on the
road. Using the IR port on the V37, you can quickly share Contacts information
with users of Pocket PCs and other mobile devices.
6HOHFWWKHFDWHJRU\RIFRQWDFWV\RX
ZDQWWRGLVSOD\LQWKHOLVW

7DSDQGHQWHUSDUWRIDQDPH
WRTXLFNO\ILQGLWLQWKHOLVW
7DSWRVHHDGGLWLRQDOSKRQH
QXPEHUVDQGHPDLODGGUHVVHV
7DSWRGLVSOD\RUHGLWWKH
FRQWDFWGHWDLOV
3UHVVDQGKROGWRGLVSOD\D
SRSXSPHQXRIDFWLRQV

7DSWRFUHDWHDQHZUHFRUG
NOTE: To change the way information is displayed in the list, tap Tools then
tap Options.
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 Tap New.
7DSWRUHWXUQWRWKHFRQWDFW
OLVW WKHFRQWDFWLVVDYHG
DXWRPDWLFDOO\ 

6FUROOWRVHHPRUHILHOGV
1RWHVLVDJRRGSODFHIRU
PDSVDQGGLUHFWLRQV

 Using the Input panel, enter a name and other contact information. You will
need to scroll down to see all available fields.

 To assign the contact to a category, scroll to and tap Categories then select
a category from the list. In the contact list, you can display contacts by
category.

 To add notes, tap the Notes tab. You can enter text, draw, or create a

recording. For more information on creating notes, see “Notes: Capturing
Thoughts and Ideas” later in this chapter.

 Tap OK to return to the contact list.

)LQGLQJD&RQWDFW
There are four ways to find a contact:
• On the Start menu, tap Find, enter the contact name, select Contacts for
the type, and then tap Go.
• In the contact list, enter a contact name in the box under the Navigation bar.
To show all contacts again, clear text from the box or tap the button to the right
of the box.
• In the contact list, tap the category list (labeled All Contacts by default)
then select the type of contact that you want displayed. To show all contacts
again, select All Contacts. To view a contact not assigned to a category,
select None.

9LHZ6RQLF3RFNHW3&9



• To view the names of companies your contacts work for, in the contact list,
tap View then tap By Company. The number of contacts that work for that
company will be displayed to the right of the company name.

8VLQJWKH6XPPDU\6FUHHQ
When you tap a contact in the contact list, a summary screen displays. To
change the contact information, tap Edit.

9LHZFRQWDFWGHWDLOV

7DSWRYLHZQRWHV

7DSWRFKDQJHFRQWDFWLQIRUPDWLRQ



9LHZ6RQLF3RFNHW3&9

7DVNV.HHSLQJD7R'R/LVW
Use Tasks to keep track of what you have to do.
6HOHFWWKHFDWHJRU\RIWDVNV\RXZDQWWR
GLVSOD\LQWKHOLVW

6HOHFWWKHVRUWRUGHURIWKHOLVW
,QGLFDWHVKLJKSULRULW\

7DSWRGLVSOD\RUHGLWWKHWDVNGHWDLOV
3UHVVDQGKROGWRGLVSOD\D
SRSXSPHQXRIDFWLRQV

7DSWRFUHDWHDQHZWDVN

9LHZ6RQLF3RFNHW3&9



&UHDWLQJD7DVN
 Tap New.
7DSWRUHWXUQWRWKHWDVNOLVW
WKH WDVNLVVDYHGDXWRPDWLFDOO\ 

7DSWRFKRRVHIURP
SUHGHILQHGVXEMHFWV

1RWHVLVDJRRGSODFHIRU
PDSVDQGGUDZLQJV

 Using the Input panel, enter a description.
 You can enter a start date and due date, or enter other information by first

tapping the field. If the Input panel is open, you will need to hide it to see all
available fields.

 To assign the task to a category, tap Categories then select a category from
the list. In the task list, you can display tasks by category.

 To add notes, tap the Notes tab. You can enter text, draw, or create a

recording. For more information on creating notes, see “Notes: Capturing
Thoughts and Ideas” later in this chapter.

 Tap OK to return to the task list.



9LHZ6RQLF3RFNHW3&9

8VLQJWKH6XPPDU\6FUHHQ
When you tap a task in the task list, a summary screen displays. To change the
task, tap Edit.

9LHZWDVNGHWDLOV
7DSWRVKRZRUKLGHDGGLWLRQDO
VXPPDU\LQIRUPDWLRQ
9LHZQRWHV

7DSWRFKDQJHWDVN

9LHZ6RQLF3RFNHW3&9



1RWHV&DSWXULQJ7KRXJKWVDQG,GHDV
Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with
Notes. You can create a written note or a recording. You can also include a
recording in a note. If a note is already open when you create the recording, it
will be included in the note as an icon. If the note list is displayed, the recording
will be created as a stand-alone recording.

7DSWRFKDQJHWKHVRUWRUGHURIWKHOLVW

7DSWRFKDQJHRSHQDQRWHRUSOD\DUHFRUGLQJ
3UHVVDQGKROGWRGLVSOD\DSRSXS
PHQXRIDFWLRQV

7DSWRUHFRUG
7DSWRVKRZRUKLGHWKH5HFRUGLQJWRROEDU
7DSWRFUHDWHDQHZLWHP

&UHDWLQJD1RWH
 Tap New.
 Create your note by writing, drawing, typing, or recording. For more

information about using the Input panel, writing and drawing on the screen,
and creating recordings, see “Entering Information” in Chapter 2.



9LHZ6RQLF3RFNHW3&9

,QER[6HQGLQJDQG5HFHLYLQJ(PDLO
Use the Inbox to send and receive e-mail messages with Microsoft Outlook on
your PC.

6\QFKURQL]LQJ(PDLO0HVVDJHV
Email messages can be synchronized as part of the general synchronization
process. To do this, you need to enable Inbox synchronization in ActiveSync.
For information on enabling Inbox synchronization, see ActiveSync Help on
the PC.
During synchronization:
• Messages are copied from the mail folders of Exchange or Outlook on your
PC to the ActiveSync folder in Inbox on your V37.
• Email messages in the Outbox folder on your V37 are transferred to
Exchange or Outlook, and then sent from those programs.
• Email messages in subfolders must be selected in ActiveSync on your PC in
order to be transferred.

8VLQJWKH0HVVDJH/LVW
Messages you receive are displayed in the message list. By default, the most
recently received messages are displayed first in the list.
6HOHFWWKH,QWHUQHW6HUYLFH3URYLGHUDQG
WKHIROGHU\RXZDQWWRGLVSOD\

6HOHFWWKHVRUWRUGHUIRUPHVVDJHV
7DSWRRSHQDPHVVDJH
3UHVVDQGKROGWRGLVSOD\DSRS
XSPHQXRIDFWLRQV

7DSWRFRQQHFWDQGWRVHQGDQGUHFHLYHHPDLO
7DSWRFRQQHFWWRWKHVHOHFWHG,QWHUQHW
6HUYLFH3URYLGHU

9LHZ6RQLF3RFNHW3&9



When you receive a message, tap it to open it. Unread messages are displayed
in bold.

7DSWRUHWXUQWRWKHPHVVDJHOLVW

7DSWRGHOHWHWKLVPHVVDJH

7DSWRYLHZWKHSUHYLRXVRUQH[WPHVVDJH
7DSWRUHSO\WRRUIRUZDUGWKLVPHVVDJH

IMPORTANT: When you synchronize with your PC, by default, you will receive
messages from the last three days only, the first 100 lines of each new
message, and file attachments of less than 100 KB in size. The original
messages remain on your PC.



9LHZ6RQLF3RFNHW3&9

To compose a message, do the following:

 Tap New.
 In the To field, enter an email of one or more recipients, separating them
with a semicolon, or select a name from the contact list by tapping the
Address Book button. All email addresses entered in the email fields in
Contacts appear in the Address Book.
7DSWRVHQGWKHPHVVDJH

7DSWRVKRZRUKLGHWKHFRPSOHWHKHDGHU

7DSWRVKRZRUKLGHWKHUHFRUGLQJWRROEDU
7DSWRGLVSOD\WKH$GGUHVV%RRN
7DSWRLQVHUWFRPPRQ IUHTXHQWO\XVHG PHVVDJHV

 Compose your message. To enter preset or frequently used messages, tap
My Text and select a message.

 Tap Send when you have finished the message. If you are working offline,
the message is moved to the Outbox folder and is sent the next time you
connect. The message is placed in the Outbox folder on your device.

0DQDJLQJ(PDLO0HVVDJHVDQG)ROGHUV
By default, messages are displayed in one of five folders for each service you
have created: Inbox, Deleted Items, Drafts, Outbox, and Sent Items. The
Deleted Items folder contains messages that were deleted from the V37.
The behavior of the Deleted and Sent Items folders depends on the options you
have chosen. In the message list, tap Tools then tap Options. On the
Message tab, select your options.
If you want to organize messages into additional sub-folders, tap Tools, then
tap Manage Folders to create new folders. To move a message to another
folder, in the message list, press and hold the message then tap Move on the
pop-up menu.

9LHZ6RQLF3RFNHW3&9





9LHZ6RQLF3RFNHW3&9

&RPSDQLRQ3URJUDPV
This chapter tells you about Microsoft Pocket Word and Microsoft Pocket Excel.

3RFNHW:RUG
Microsoft Pocket Word works with Microsoft Word on your PC to give you easy
access to copies of your documents. You can create new documents on your
V37 or you can copy documents from your PC.
IMPORTANT: Synchronize documents between your PC and your V37 regularly
so that you have the most up-to-date content in both locations.

8VLQJ3RFNHW:RUG
 On the Start, tap Programs and then tap the Pocket Word icon.
 Type the name of a document in the file list or tap New to open a blank
document.

NOTE: To open a template rather than a blank document, select a template for
new documents. Tap on the Tools menu, tap Options, then browse to select
the default template. When you tap New, the template appears with
appropriate text and formatting already provided.
You can open only one document at a time; when you open a second document,
you will be asked to save the first. You can save a document you create or edit
in a variety of formats, including Pocket Word (.psw), Rich Text Format (.rtf),
and Plain Text (.txt).
You can enter information in Pocket Word in four modes: writing, drawing,
typing, and recording. Use the View menu to switch between modes. Each
mode has its own toolbar which you can show or hide by tapping the Show/
Hide Toolbar button on the Command bar.
• Typing Mode. Use the Input panel to enter typed text into the document
with the soft keyboard. For more information on entering typed text, see
“Entering Information” in Chapter 2.
• Writing Mode. In writing mode, use your stylus to write directly on the
screen. Ruled lines are displayed as a guide, and the zoom magnification is
greater than in typing mode to allow you to write more easily. For more
9LHZ6RQLF3RFNHW3&9



information on writing and selecting writing, see “Entering Information” in
Chapter 2.
NOTE: Written words are converted to graphics (metafiles) when a Pocket
Word document is converted to a Word document on your PC.
• Drawing mode. In drawing mode, use your stylus to draw on the screen.
Gridlines appear as a guide. When you lift your stylus off the screen after
the first stroke, you will see a drawing box indicating the boundaries of the
drawing. Every subsequent stroke within or touching the drawing box
becomes part of the drawing. For more information on drawing and selecting
drawings, see “Entering Information” in Chapter 2.
• Recording mode. Use recording mode to embed a recording into your
document. Recordings are saved as WAV files. For more information on
recording, see “Entering Information” in Chapter 2.

7LSVIRU:RUNLQJLQ3RFNHW:RUG
• You can change the zoom magnification by tapping View and then taping
Zoom. Then select the percentage you want. Select a higher percentage to
enter text and a lower one to see more of your document.
• If you are opening a Word document created on a PC, select Wrap to
Window on the View menu so that you can see the entire document.

3RFNHW([FHO
Microsoft Pocket Excel works with Microsoft Excel on your PC to give you easy
access to copies of your workbooks. You can create new workbooks in your
V37, or you can copy workbooks from your PC to your V37. Synchronize
workbooks between your PC and your V37 so that you have the most up-todate content in both locations. Pocket Excel provides fundamental spreadsheet
tools, such as formulas, functions, sorting, and filtering, which enable you to
create simple workbooks, such as expense reports and mileage logs.

 On the Start menu, tap Programs and then tap the Pocket Excel icon.
 Tap the name of a workbook in the file list or tap New to open a blank
workbook.

You can open only one workbook at a time; when you open a second workbook,
you will be asked to save the first. You can save a workbook you have created
or edit in a variety of formats, including Pocket Excel (.pxl) and Excel (.xls).

7LSVIRU:RUNLQJLQ3RFNHW([FHO
• View in full-screen mode to see as much of your worksheet as possible. Tap
View and then tap Full Screen. To exit full-screen mode, tap Restore.
• If your workbook contains sensitive information, you can protect it with a
password. To do so, open the workbook, tap Edit, and then tap Password.
• Show or hide window elements. Tap View then tap the elements you want
to show or hide.



9LHZ6RQLF3RFNHW3&9

• Freeze panes on a worksheet. First, select the cell where you want to freeze
panes. Tap View and then tap Freeze Panes. You might want to freeze the
top and furthest left panes in a worksheet to keep row and column labels
visible as you scroll through a sheet.
• Split panes to view different areas of a large worksheet. Tap View and then
tap Split. Then drag the split bar to where you want it. To remove the split,
tap View and then tap Remove Split.
• Show and hide rows and columns. To hide a row or column, select a cell in
the row or column you want to hide, tap Format, tap Column, then tap
Hide. To show a hidden row or column, tap Tools, tap Go To then type a
reference that is in the hidden row or column. Tap Format, then tap Row or
Column, then tap Unhide.

:LQGRZV0HGLD3OD\HUIRU3RFNHW3&
Use Microsoft Windows Media Player for V37 to play digital audio and video files
that are stored on your V37 or on a network. To switch to Windows Media
Player for V37, tap

and tap Windows Media.

7DSWRGLVSOD\WKH:LQGRZV0HGLDFRP
ZHEVLWH

7DSWRDGMXVWWKHSOD\EDFNSURJUHVV
RIDVHOHFWHGILOH

7DSWRDGMXVWYROXPH
7DSWRGLVSOD\DYLGHRXVLQJWKHHQWLUHVFUHHQ
7DSWRVNLSWRWKHQH[WILOH
7DSWRSOD\DSUHYLRXVILOH
7DSWRVWRS
7DSWRSOD\RUSDXVH
Use Microsoft Windows Media Player on your PC to copy digital audio and video
files to your V37. You can play Windows Media and MP3 files on your V37.
For more information about using Windows Media Player, tap
9LHZ6RQLF3RFNHW3&9

then tap Help.


0LFURVRIW5HDGHU
Use Microsoft Reader to read eBooks on your V37. Download books to your PC
from your favorite eBook Web site. Use ActiveSync to copy the book files to
your activated V37. The books appear in the Reader Library, where you can tap
them in the list to open them.
NOTE: Before you can use Microsoft Reader, you must activate it from the
Microsoft activation site (http://das.microsoft.com/activate). Follow the
directions given at the Microsoft site.
Each book consists of a cover page, an optional table of contents, and the
pages of the book. You can:
• Page through the book by using the scroll dial on your V37 or by tapping the
page number on each page.
• Annotate the book with highlighting, bookmarks, notes, and drawings.
• Search for text or look up definitions for words.
The Guidebook contains all the information you need to use the software. To
open the Guidebook, tap Help on the Reader command bar. Or, on a book
page, press and hold on the book title, and then tap Help on the pop-up menu.
To switch to Microsoft Reader, tap
Reader.

, tap Programs then tap Microsoft

*HWWLQJ%RRNVRQWR<RXU9
You can download book files from the Web. Just visit your favorite eBook
retailer and follow the instructions to download the book files.
Sample books and a dictionary are also included in the MSReader folder on the
Companion CD.
Use ActiveSync to download the files from your PC to your activated V37 as
described in the Read Me file in the MSReader folder.



9LHZ6RQLF3RFNHW3&9

8VLQJWKH/LEUDU\
The Library is your Reader home page. The home page displays a list of all
books stored on your V37 or storage card.
To open the Library:
• On the Reader command bar, tap Library.
• On a book page, tap the book title, and tap Library, on the pop-up menu.
To open a book, tap its title in the Library list.

7DSWRVHOHFW
DVRUWRUGHU

7DSWRVSHFLI\WKH
ERRNV\RXZDQWWR
GLVSOD\LQWKHOLVW

7DSWRVFUROO
WKURXJKWKH
/LEUDU\OLVW

7DSWRRSHQD
ERRN

7DSKHUHWRQDYLJDWH
WRRWKHUSDUWVRIWKH
5HDGHU

9LHZ6RQLF3RFNHW3&9



5HDGLQJD%RRN
Each book consists of a cover page, an optional table of contents, and the
pages of the book. Navigation options are listed in the bottom portion of the
cover page.
The first time you open a book, you will probably want to go to the first page or
to the table of contents, if there is one. Subsequently, whenever you open the
book, you automatically go to the last page read.
In addition to the text, each book page includes a page number and book title.

7DSWRVHOHFWD
QDYLJDWLRQRSWLRQ
'UDJWRVHOHFWWH[W
DQGWKHQWDSDQ
RSWLRQ

7DSDUURZVWRWXUQ
WKHSDJHRUSUHVV
DQGKROGSDJHWR
EULQJXSSDJHWLWOH
You can also page through a book by using the scroll dial on your V37.

8VLQJ5HDGHU)HDWXUHV
Reading a book electronically gives you several options not available with paper
books. These options are available from any book page.
Select text by dragging across the text on the page. Then, tap an option on the
pop-up menu, as described here.
• Search for Text. Find text in a book by tapping Find on the pop-up menu.
Enter the word you want to search for, and tap the desired Find option.
Reader highlights found text on the page. To close Find, tap outside the box.
To return to your original page, tap the title and then tap Return on the
popup menu.
• Copy Text. You can copy text from books that support this feature into any
program that accepts text. On a book page, select the text you want to
copy. Then, tap Copy Text on the pop-up menu. The text can be pasted into
the program of your choice.



9LHZ6RQLF3RFNHW3&9

• Bookmarks. When you add a bookmark to a book, a color-coded bookmark
icon appears in the right margin. You can add multiple bookmarks to a book.
Then, from anywhere in the book, tap the bookmark icon to go to the
bookmarked page.
• Highlights. When you highlight text, it appears with a colored background.
• Notes. When you attach a note to text, you enter the text in a note pad that
appears on top of the book page. A Note icon displays in the left margin. To
show or hide the note, tap the icon.
• Drawings. When you add a drawing, a Drawing icon appears in the bottomleft corner of the page and drawing tools appear across the bottom of the
page. Draw by dragging your stylus.
NOTE: To see a list of a book’s annotations, including bookmarks, highlights,
text notes, and drawings, tap Annotations Index on the book’s cover page.
You can tap an entry in the list to go to the annotated page.

5HPRYLQJD%RRN
When you finish reading a book, you can delete it to conserve space on your
V37. If a copy of the book is stored on your PC, you can download it again at
any time.
To remove a book from your V37, press and hold the title in the Library list, and
then tap Delete on the pop-up menu.

9LHZ6RQLF3RFNHW3&9



2WKHU3URJUDPV
The following programs are permanently installed in your V37:

3URJUDP

+RZWR$FFHVVWKH3URJUDP

Infrared
Receiver

On the Start menu, tap Programs and then tap the
Infrared Receive icon. Infrared Receive establishes the
connection between your V37 and the IR device.

Terminal
Services

On the Start menu, tap Programs and then tap the
Terminal Services icon. Terminal Services allows you to
access the programs and documents in a Windows NT server
type PC that is running Terminal Services.

Backup

On the Start menu, tap Programs and then tap the Backup
icon. Backup enables you to back up all data stored in the
internal (RAM) memory on your V37. For more information,
see section “Backing up Data” in Chapter 3.

.NET Compact .NET Compact Framework is built into the V37’s Flash ROM
Framework
image. Microsoft’s Compact Framework provides developers
an easy to use tool to develop managed code and XML web
service clients for Pocket PCs and other smart devices.
Because Compact Framework is a subset of Framework,
developers can reuse existing Visual Studio .NET code and
skills in smart device, desktop, and server environments.
You can also install the following programs from the V37 Companion CD:



3URJUDP

'HVFULSWLRQ

ClearVue™
Image Viewer

Allows you to view BMP, JPG, and PNG
images.

ClearVue™
Presentation
Viewer

Allows you to view presentations created
with Microsoft PowerPoint 97, PowerPoint
2000, and PowerPoint 2002 (XP).

9LHZ6RQLF3RFNHW3&9

3RFNHW,QWHUQHW([SORUHU
This chapter tells you about Microsoft Pocket Internet Explorer, Mobile Favorites
Folder and AvantGo Channels.

8VLQJ3RFNHW,QWHUQHW([SORUHU
Use Microsoft Pocket Internet Explorer to view Web pages by doing the
following:
• During synchronization with your PC, download your favorite links and
mobile favorites that are stored in the Mobile Favorites subfolder in Internet
Explorer on the PC.
To start Pocket Internet Explorer:
• On the Start menu, tap Internet Explorer. The Pocket Internet Explorer
home page:

+LGHSLFWXUHVEXWWRQ
)DYRULWHVEXWWRQ
+RPHEXWWRQ
5HIUHVKEXWWRQ
9LHZ6RQLF3RFNHW3&9



9LHZLQJ0RELOH)DYRULWHVDQG&KDQQHOV
 Tap the Favorites button to display your list of favorites.
 In the list, tap the page you want to view.

7DSWKH)DYRULWH\RXZDQWWRYLHZ

7DSWRDGGRUGHOHWHD
IROGHURU)DYRULWHOLQN

You will see the page that was downloaded the last time you synchronized with
your PC. If the page is not on your V37, it will be dimmed in the Favorites list.
You will need to synchronize with your PC again to download the page to your
V37, or connect to the Internet to view the page.

%URZVLQJWKH,QWHUQHW
To connect and start browsing, do one of the following:
• Tap the Favorites button, and then tap the favorite you want to view.
• Tap View, and then tap Address Bar. In the address bar that appears at
the top of the screen, enter the Web address you want to visit and then tap
Go. Tap the arrow to choose from previously entered addresses.

7KH0RELOH)DYRULWHV)ROGHU
Only items stored in the Mobile Favorites subfolder in the Favorites folder in
Internet Explorer on your PC will be synchronized with your Pocket PC. This
folder is created automatically when you install ActiveSync.



9LHZ6RQLF3RFNHW3&9

)DYRULWH/LQNV
During synchronization, the list of favorite links in the Mobile Favorites folder on
your PC is synchronized with Pocket Internet Explorer on your V37. Both
computers are updated with changes made to either list each time you
synchronize. Unless you mark the favorite link as a mobile favorite, only the
link (and not the page) will be downloaded to your V37, and you must connect
to your ISP or network to view the content. For more information on
synchronization, see ActiveSync Help on your PC.

0RELOH)DYRULWHV
If you are using Microsoft Internet Explorer 5 or later on your PC, you can
download mobile favorites to your V37. When you synchronize your PC and
V37, the content of your mobile favorites is downloaded to your V37 so that you
can view pages while you are not connected to your ISP or your network.
Use the Internet Explorer plug-in installed with ActiveSync to create mobile
favorites quickly.
To create a mobile favorite:

 In Internet Explorer on your PC, click Tools, and then click Create.
• To change the link name, enter a new name in the Name box.
• To change how often the mobile favorite is updated, select a desired
update schedule under Update.

 Click OK. Internet Explorer downloads the latest version of the page to
your PC.

 If you want to download the pages that are linked to the mobile favorite you
just created, right-click the mobile favorite and then click Properties. On
the Download tab, specify the number of links deep you want to download.
To conserve memory on your V37, download only one level of links.

 Synchronize your V37 and PC. Mobile favorites that are stored in the Mobile
Favorites folder in Internet Explorer are downloaded to your V37.

NOTE: If you do not specify an updated schedule, you must manually download
content to keep the information updated on your PC and V37. Before
synchronizing in Internet Explorer or your PC, click Synchronize on the Tools
menu. You will see the last time content was downloaded to your PC, and you
can manually download if needed.
NOTE: You can add a button to the Internet Explorer toolbar for creating
mobile favorites. In Internet Explorer on your PC, on the View menu, click
Toolbars, and then click Customize.

&RQVHUYLQJ0HPRU\
Mobile favorites take up storage memory on your V37. Follow these tips to
minimize the amount of memory used:

9LHZ6RQLF3RFNHW3&9



• Use ActiveSync settings to turn off pictures and sounds for the Mobile
Favorites information type or to stop some mobile favorites from being
downloaded to your V37. For more information, see ActiveSync Help.
• Limit the number of downloaded linked pages. In Internet Explorer on the
PC, right-click the mobile favorite you want to change, and then click
Properties. On the Download tab, specify 0 or 1 for the number of linked
pages you want to download.

8VLQJ$YDQW*R&KDQQHOV
AvantGo is a free interactive service that gives you access to personalized
content and thousands of popular Web sites. You subscribe to AvantGo channels
directly from your V37. Then you synchronize your V37 with your PC or connect
to the Internet to download the content. For more information, visit the
AvantGo Web site.
To sign up for AvantGo:

 In ActiveSync options on the PC, turn on synchronization for the AvantGo
information type.

 In Pocket Internet Explorer on your V37, tap the Favorites button to display
your list of favorites.

 Tap the AvantGo Channels link.
 Tap the Activate button.
 Follow the directions on the screen. You will need to synchronize your V37
with your PC, and then tap the My Channels button to complete the
AvantGo setup.

When synchronization is complete, tap the AvantGo Channels link in your list
of favorites to see a few of the most popular channels. To add or remove
channels, tap the Add or Remove link.
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*HWWLQJ&RQQHFWHG
This chapter explains how to connect your V37 to the Internet or to a network
using a wireless connection. In addition, the chapter explains how to connect to
other mobile devices or your PC using an infrared (IR) connection.

&RQQHFWLQJWRD1HWZRUNRUWKH,QWHUQHW
You can connect to a wireless network at work or at home by installing an SDIO
802.11B (WiFi) network card (purchased separately) into the V37’s SDIO slot.
Once connected to a network, you can send and receive email messages using
Inbox and/or access web pages on the Internet using Pocket Internet Explorer.
See Creating a Wireless Connection to a Network below for information about
using a wireless connection.

&UHDWLQJD:LUHOHVV&RQQHFWLRQWRD1HWZRUN
You first need to install an 802.11B (WiFi) SDIO network card (purchased
separately). For instructions on inserting and using the SDIO WiFi or network
card, see the owner’s manual for the card.
NOTE: Make sure your SDIO card is compatible with SDIO Now! technology,
developed by bSquare Inc.

 If applicable, obtain the following information from your network
administrator: user name, password, and domain name.

 You do not need to create a new connection on your V37. The first time you

install the SDIO network card, Network Settings appears automatically so
you can configure the network card. Most networks use DHCP, so you should
not have to change settings unless your network administrator instructs you
to do so. If you need to change settings, do the following: Tap OK. If it does
not appear to change settings later, tap
and tap Settings. On the
Connections tab, tap Network Adapters, tap the adapter you want to
change, and tap Properties.

 Tap

, tap Settings, and tap the Connections tab. From My network
card connects to list, tap Work, and tap OK.

9LHZ6RQLF3RFNHW3&9



&UHDWLQJD:LUHOHVV&RQQHFWLRQWRWKH,QWHUQHW
You first need to install an 802.11B (WiFi) SDIO network card (purchased
separately). For instructions on inserting and using the SDIO WiFi or network
card, see the owner’s manual for the card.
NOTE: Make sure your SDIO card is compatible with SDIO Now! technology,
developed‘ by bSquare Inc.

 If applicable, obtain the following information from your ISP (Internet
Service Provider): user name, password, and domain name.

 You do not need to create a new connection on your V37. The first time you

install the SDIO network card, Network Settings appears automatically so
you can configure the network card. Most networks use DHCP, so you should
not have to change settings unless your network administrator instructs you
to do so. If you need to change settings, do the following: Tap OK. If it does
not appear to change settings later, tap
and tap Settings. On the
Connections tab, tap Network Adapters, tap the adapter you want to
change, and tap Properties.

 Tap

, tap Settings, and tap the Connections tab. From the My network
card connects to list, tap The Internet, and tap OK.

8VLQJDQ,QIUDUHG&RQQHFWLRQ
An infrared (IR) connection will allow you use your V37 to exchange information
(such as contacts and appointments) with other mobile devices as well as your
PC. (For more information, see “Using Microsoft ActiveSync” in Chapter 4.)
Use the infrared (IR) port on the V37 to exchange (send/receive) files with
another mobile device.

6HQGLQJ,QIRUPDWLRQ
 Switch to the program in which you created the item you want to send then
locate the item in the list.

 Align the IR ports so that they are unobstructed and within a close range.
CAUTION: If the devices are too far apart or if something blocks the
path between the two ports, data might not be sent or received
correctly.

 Press and hold the item, then tap Beam Item on the pop-up menu.
NOTE: You can also send items, but not folders, from File Explorer. Press and
hold the item you want to send, then tap Beam File on the pop-up menu.

5HFHLYLQJ,QIRUPDWLRQ
 Align the IR ports so that they are unobstructed and within a close range.
 Tap

, tap Programs, then tap Infrared Receive.

 Have the owner of the other device send the information to you. Your V37
will automatically receive it.
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7URXEOHVKRRWLQJDQG
0DLQWHQDQFH
This chapter gives solutions to common V37 problems you may encounter when
using the device. It also provides guidelines on taking care of your V37.
NOTE: If you encounter a problem you cannot solve, contact your reseller or
ViewSonic Customer Support. See the “Customer Support” section at the end of
this chapter.

5HVHWWLQJ\RXU9
CAUTION: Resetting will cause unsaved data to be lost.
Resetting your V37 is similar to restarting your PC. It restarts the operating
system, but you will lose any unsaved data. Occasionally, you may need to
reset your V37. For example, you should reset your V37:
• After you restore data from your PC.
• When your V37 stops responding. (In other words, it appears to be “frozen”
or “locked up.”)
Follow this procedure to reset your V37:

 Remove the memory card (if installed).

9LHZ6RQLF3RFNHW3&9



 Unscrew the cap at the top of the stylus. Use the pointed tip of the cap to
press the reset button on the side of your V37.

5HVWRULQJ)DFWRU\'HIDXOWV
In some cases, you may need to restore your V37 to the factory default settings
by clearing the memory (RAM) from your V37. For example, you should clear
the memory:
• When your V37 does not respond after being reset.
• When you forget your password.
Clearing the memory means all data you have entered in RAM, including all
files, system settings, and additional programs you have installed, will be
erased. (Programs installed to ROM at the factory are not affected.)
CAUTION:
• To ensure the integrity of your data should it be necessary to clear
the memory, you are advised to regularly back up to your PC (using
ActiveSync), or to an optional SD card (using the backup
application). For more information on backing up data, see “Backing
Up Data” in Chapter 3.
• Do not push the battery switch unless it is necessary.
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)ROORZWKLVSURFHGXUHWRFOHDUWKHPHPRU\IURP\RXU9
 Disconnect all cables, including the AC adapter, from your V37.
 Unscrew the cap at the top of the stylus. Use the pointed tip of the cap to
push the battery switch to the OFF (up) position.

 Wait for three (3) minutes then push the battery switch to the ON (down)
position.

 The Notification indicator will flash red for approximately 30 seconds, and
then your V37 will automatically turn on and display the Welcome Wizard
screen.

NOTE: If the battery runs completely out of power and is not re-charged in
time, the memory of your V37 will be cleared.

3RZHU3UREOHPV
3RZHUGRHVQRWWXUQRQZKHQXVLQJEDWWHU\SRZHU
• The remaining battery power may be too low to run your V37. Connect the
AC adapter to your V37 and to external AC power. Then, turn on your V37.
(Charge the battery whenever possible to avoid running out of battery
power.)

%DWWHU\UXQVRXWRISRZHUTXLFNO\
• You might be using your V37 in ways that drain power quickly. (See
“Managing Power” in Chapter 3 for tips on saving power.)

9LHZ6RQLF3RFNHW3&9



0HPRU\3UREOHPV
If a warning message of not enough memory appears due to the memory
allocation problem, try the following to free memory on your V37.
CAUTION: Be discreet when you delete files. Deleting files of which the
function is unknown can cause programs or features to malfunction. It
is recommended that you to create a backup before deleting files.
• Delete files you no longer need. Tap
, Programs, and then File Explorer.
Press and hold the file you wish to delete, then tap Delete on the pop-up
menu. To find your largest files, tap
then Find. In the Type list, tap
Larger than 64KB, then tap Go.
• Remove programs you no longer need. Tap
and then Settings. Tap
System tab, then tap Remove Programs. Tap the program you want to
remove then tap Remove.
• In Internet Explorer options, delete all files then clear history. In Internet
Explorer, tap Tools then Options. Tap Delete Files then Clear History.
• If you are copying files from a computer or other device to your V37, try
adjusting the slider in the Memory setting. Tap
then Settings. Tap
System tab, then tap Memory. Check to see if you can manually move the
slider before copying files.
Stop programs you are not currently using. In most cases, programs
automatically stop to free needed memory. However, in some situations, such
as when confirmation dialog boxes are waiting for a user response, the program
may not be able to automatically stop. To check the state of your active
programs, tap
then Settings. Tap System tab, tap Memory, then Running
Programs. Tap the program you want to view then tap Activate. Close any
open windows or messages and return the program to list view. If this does not
work, you can stop the program manually. First, make sure that your work is
saved by closing open items and return the program to list view. Then, stop the
program by tapping Stop or Stop All on the Running Programs tab.
Reset your V37 as described earlier in this chapter.

,I\RXKDYHDQ6'FDUGPRYHGDWDWRWKH6'FDUGDVIROORZV
• Tap
, Programs, then File Explorer. Press and hold the file you want to
move, then tap Cut. Browse to My Documents folder in the SD card folder,
tap Edit, then Paste. Files stored in folders other than My Documents or
stored in subfolders within subfolders in My Documents may not show up in
the list view of some programs. When using Notes, Pocket Word, or Pocket
Excel, you can also move files by opening the item then tapping Tools or
Edit then Rename/Move.
Files stored in folders other than My Documents or stored in subfolders
within subfolders in My Documents may not show up in the list view of some
programs. When using Notes, Pocket Word, or Pocket Excel, you can also
move files by opening the item then tapping Tools or Edit then Rename/
Move.
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6FUHHQ3UREOHPV
6FUHHQLVRII
If the screen does not respond, even after you press the power button, try the
following until the problem is solved:
• Connect the AC adapter to your V37 and to external AC power, then
• Reset your V37 as described in “Resetting Your V37” earlier in this chapter.

6FUHHQUHVSRQGVVORZO\
• Make sure that your V37 is not running out of battery power or running
many active programs. If the problem still exists, reset your V37 as
described in “Resetting Your V37” earlier in this chapter.

6FUHHQIUHH]HV
• Reset your V37 as described in “Resetting Your V37” earlier in this chapter.

6FUHHQLVKDUGWRUHDG
• Make sure that the backlight of the display is on.
• Move to a location with enough light.
• If you are having a hard time reading a document on the screen, try
adjusting the zoom percentage or text size.
- In Notes, tap Tools and select a zoom percentage.
- In Pocket Word and Pocket Excel, tap View, tap Zoom then select a zoom
Percentage.
- In Pocket Internet Explorer, tap View, tap Text Size then select a size.
- In Calendar, Contacts, and Tasks, tap Tools, tap Options then select User
large font.

,QDFFXUDWHUHVSRQVHWRVW\OXVWDSV
Realign the touch screen. Tap
and tap Settings. Tap System tab then tap
Align Screen. If you cannot realign the touch screen, turn off the V37. Press
and hold the scroll dial, then press the power button to turn on the V37. You
should now be able to start the touch screen alignment process.

9&RQQHFWLRQ3UREOHPV
86%&UDGOH&RQQHFWLRQ3UREOHPV
• Make sure that you have installed the correct version of ActiveSync on your
desktop PC. Install the version ActiveSync included with your V37.
• Make sure that your V37 and your desktop PC are turned on.
• Make sure that you do not have any other active connections.
• When using the USB cradle, make sure that your V37 is properly seated.
9LHZ6RQLF3RFNHW3&9



• Make sure that the cable is securely plugged into the USB port on your
desktop PC. Connect the USB cable directly to your desktop PC — do not run
the cable through a USB hub.
• Make sure that the USB connection is enabled in ActiveSync on your desktop
PC. If the USB connection is already enabled, disable the USB connection,
close the Connection Settings window, and then reopen and re-enable the
USB connection.
• Reset your V37 before connecting the USB cable. (See “Resetting Your V37”
earlier in this chapter.) Always disconnect your V37 before you restart your
desktop PC.
• Connect only one V37 or personal digital assistant to your desktop PC at
a time.

1HWZRUN&RQQHFWLRQ3UREOHPV
• Make sure that the SDIO network card is compatible with your Pocket PC
V37 (compatible with SDIO Now! technology, developed by bSquare Inc.)
• Make sure that you have installed the proper drivers for your V37.
• In the Properties for your network card, make sure that you have correctly
configured the IP settings, and the addresses of your DNS servers and/or
WINS servers. Your network administrator can verify this.
• Make sure that you have added necessary server information. Tap
and
then Settings. Tap the Connections tab, and then tap Network
Adapters. Select the installed network card (usually the card’s name) and
enter any necessary information. Most networks use DHCP to assign IP
addresses dynamically; you should not have to change or enter any IP
address unless you network administrator instructs you to do so.
• Verify with your network administrator that your user name and password
are correct.
• Verify with your network administrator that the network you are trying to
connect to is available, or try to connect to it from another computer.
• You may need to change the device name if you are trying to connect to a
network and cannot because another device with the same name is already
connected. To change the device name, tap
and then Settings. Tap the
System tab, tap About, and then tap the Device ID tab.

,QIUDUHG&RQQHFWLRQ3UREOHPV
• Transfer only one file, or no more than 25 contact cards, at a time.
• Position the IR ports so that they line up at a distance less than 20 cm (8
inches) but more than 5 cm (2 inches) apart.
• Make sure that there are no obstacles between the two IR ports.
• Adjust the room lighting. Some types of light interfere with IR
communications. Try moving to a different location or turning off some
lights.



9LHZ6RQLF3RFNHW3&9

&DUHDQG0DLQWHQDQFH
Taking good care of your V37 will ensure trouble-free operation and reduce the
risk of damage to your V37.

*HQHUDO*XLGHOLQHV
• Keep your V37 away from excessive moisture and extreme temperatures.
• Avoid exposing your V37 to direct sunlight or strong ultraviolet light for
extended periods of time.
• Do not place anything on top of your V37 as this may damage the display.
• Do not drop your V37.
• Store your V37 in a protective case when not in use.
• The screen surface is easily scratched. Use only the stylus to tap on the
screen. Avoid touching it with your fingers, pens, or pencils.
• Never clean your V37 with the power on. Use a soft, lint-free cloth
moistened with water to wipe the screen and the exterior of your V37.
• Never use paper towels to clean the screen.

7UDYHO*XLGHOLQHV
• Before traveling with your V37, back up your data. As an added precaution,
bring along a backup copy.
• Turn off your V37 and disconnect all external devices.
• Make sure that the battery is fully charged.
• Take the AC adapter with you. Use the AC adapter as the power source and
as a battery-recharger.
• Hand-carry your V37 in a protective case.
• Consult the airlines first before using your V37 on the plane. You need to be
very careful when using electronic devices during the flight.
• If you plan to travel abroad with your V37, consult your dealer for the
appropriate AC adapter for use in your country of destination.
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&XVWRPHU6XSSRUW
For technical support or product service, see the table below or contact your
reseller.
IMPORTANT:
• You will need to provide the product serial number (on the back of
the V37).
• Before sending the V37 out for service, be sure to backup all data
and remove all third party software. See the Data Loss Disclaimer in
the Appendix

&RXQWU\
5HJLRQ

:HEVLWH(PDLO

7 7HOHSKRQH
) )$;

8QLWHG6WDWHV

ZZZYLHZVRQLFFRPVXSSRUW
YVWHFK#YLHZVRQLFFRP

7  
)  

&DQDGD

ZZZYLHZVRQLFFRPVXSSRUW
YVWHFK#YLHZVRQLFFRP

7  
)  

8QLWHG.LQJGRP

ZZZYLHZVRQLFHXURSHFRP
7
VHUYLFHHX#YLHZVRQLFHXURSHFRP )

(XURSH0LGGOH
(DVW%DOWLF
FRXQWULHVDQG
1RUWK$IULFD

ZZZYLHZVRQLFHXURSHFRP
&RQWDFW\RXUUHVHOOHU
VHUYLFHHX#YLHZVRQLFHXURSHFRP

$XVWUDOLDDQG1HZ ZZZYLHZVRQLFFRPDX
=HDODQG
VHUYLFHDX#YLHZVRQLFFRP
6LQJDSRUH,QGLD
DQG6RXWKHDVW
$VLD

ZZZYLHZVRQLFFRPVJ
VHUYLFHVJ#YLHZVRQLFFRP

2WKHU$VLD3DFLILF ZZZYLHZVRQLFFRPWZ
FRXQWULHV
VHUYLFHDS#YLHZVRQLFFRPWZ
6RXWK$IULFD



ZZZYLHZVRQLFFRPDVLD
VHUYLFHDS#YLHZVRQLFFRP

7
)
7
)
7
)
7
)
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$SSHQGL[
5HJXODWRU\DQG6DIHW\,QIRUPDWLRQ
&ODVV%5HJXODWLRQV

86$
This equipment complies with the limits for a class B digital device as specified
in Part 15 of FCC Rules which provide reasonable protection against harmful
interference in a residential area. This equipment generates and uses radio
frequency energy, and if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular
installation. In the unlikely event that there is interference to radio or television
reception (which can be determined by turning the equipment off and on), the
user is encouraged to try to correct the interference by one or more of the
following measures:
• Reorienting or relocating the receiving antenna (radio or television).
• Relocating the equipment with respect to the receiver.
• Consult your dealer or an experienced radio/television technician.
• Any changes or modifications to the equipment not expressly approved by
the manufacturer could void the user's authority to operate this equipment.
• Use of a shielded interface cable is required to comply with the Class B limits
of Part 15 of FCC rules.

&DQDGD
This Class B digital apparatus meets all requirements of the Canada
Interference-Causing equipment regulations.
Cet appareil numérique de Classe B respecte toutes les exigences du
Règlement Canadien sur le matériel brouileur.
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(XURSHDQ5HJXODWRU\1RWLFH
Products with the CE mark comply with both the Electromagnetic Compatibility
Directive (89/336/EEC) and the Low Voltage Directive (73/23/EEC) - as
mandated by Directive 93/68/ECC - issued by the Commission of the European
Community.
Compliance with these directives implies conformity to the following European
standards:
EN55022: Radio disturbance characteristics
EN55024: Immunity characteristics
EN6100-3-2: Limits for harmonic current emissions
EN6100-3-3: Limitation of voltage fluctuation and flicker in low-voltage
supply system
EN60950: Product Safety

%DWWHU\5HSODFHPHQW
A Lithium Ion battery in this Pocket PC maintains system configuration
information. In the event that the battery fails to maintain system
configuration, we recommend that you call your local dealer.
The battery must be replaced by authorized service personnel. Contact your
dealer or ViewSonic for service contact information. Do not attempt to
replace the battery yourself.

:$51,1*7KLVXQLWFRQWDLQVD/LWKLXP,RQEDWWHU\WKDWLVQRWXVHU
UHSODFHDEOH7RUHGXFHULVNRIILUHRUEXUQVGRQRWGLVDVVHPEOH
FUXVKSXQFWXUHRUGLVSRVHRIWKHEDWWHU\LQILUHRUZDWHU
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$ERXWWKH$&$GDSWHU
CAUTION: Only use the AC adapter (PHIHONG, PSC0R-050) supplied
with your Pocket PC V37. Use of another type of AC adapter will result
in malfunction and/or danger.
NOTE: This product is intended to be supplied with a Listed Power Unit marked
“LPS” and output rated +5 V DC / 900 mA minimum.
The AC adapter is designed to ensure your personal safety and to be compatible
with this equipment. Please follow these guidelines:
• Do not use the adapter in a high moisture environment. Never touch the
adapter when your hands or feet are wet.
• Allow adequate ventilation around the adapter. Avoid locations with
restricted airflow.
• Connect the adapter to a proper power source. The voltage and grounding
requirements are found on the product case and/or packaging.
• Do not use the adapter if the cord becomes damaged.
• Do not attempt to service the unit. There are no serviceable parts inside.
Replace the unit if it is damaged or exposed to excess moisture.

$ERXW(OHFWURVWDWLF'LVFKDUJH
(OHFWURVWDWLF'LVFKDUJH:DUQLQJ
Electrostatic discharges can interfere with the normal functioning of electronic
devices. Your Pocket PC can behave abnormally owing to such an event,
resulting in the possible data corruption or loss of unsaved data. To recover
from this, reset your Pocket PC as described in this User Guide.
NOTE: To avoid losing data due to electrostatic discharges or other types of
events, it is recommended that you regularly save and backup data as
described in this User Guide.
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/LPLWHG:DUUDQW\
3RFNHW3&3URGXFWV
:KDWWKHZDUUDQW\FRYHUV
9LHZ6RQLFZDUUDQWVLWV3RFNHW3&SURGXFWVWREHIUHHIURPGHIHFWVLQPDWHULDODQGZRUNPDQVKLSGXULQJ
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'DWD/RVV'LVFODLPHU
Before sending the V37 out for service, be sure to backup all data and remove
all third party software.
With respect to all service provided, it is your responsibility to backup the
contents of your V37, including any data you have stored or software you have
installed on the V37. It is likely that the contents of your V37 will be lost in the
course of service and ViewSonic will not be responsible for any damage to or
loss of any programs, data or other information stored on any media or any
part of any Product serviced hereunder.
IF DURING THE REPAIR OF THE PRODUCT THE CONTENTS OF THE V37 ARE
ALTERED, DELETED, OR IN ANY WAY MODIFIED, VIEWSONIC IS NOT
RESPONSIBLE WHATSOEVER. YOUR PRODUCT WILL BE RETURNED TO YOU
CONFIGURED AS ORIGINALLY PURCHASED (SUBJECT TO AVAILABILITY OF
SOFTWARE).
Be sure to remove all third party hardware, software, features, parts, options,
alterations, and attachments not warranted by ViewSonic prior to sending the
product to ViewSonic for service. ViewSonic is not liable for any loss or damage
to these items.
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